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Today we‟re going to show you how you would set up a spreadsheet model of the modeling 

problem about how many ping pong balls would fit inside the room that you‟re sitting in.  So 

let‟s start by opening up a brand new worksheet.  And then we‟ll begin by having a graphical 

representation of the room you‟re sitting in.  

 

So go up to the ribbon and click on the Insert tab, and then choose the Shapes button.  And 

we‟re going to add a cube to our spreadsheet.  Just click on that cube, and then click on your 

spreadsheet, and a cube is inserted.  And we can use our mouse to grab the corners of that 

cube to change the dimensions so it might look more room-like.  So here you are, and here‟s 

the room you‟re sitting in.  And this is a graphical representation of a room.  

 

Now this room has dimensions.  It has a length, which is indicated in this axis.  It has a height, 

and it has a depth.  And just to make things a little bit clear, let‟s go ahead and label those.  H 

for height, L for length, and D for depth.  And in order to show the D, let‟s choose cell B4 and 

then right-align it so the D is shown.  So that is our room that we‟re dealing with here.  

 

And our goal is to find out how many ping pong balls would fit inside this particular room.  

 

So in order to know that, you need to know, first, how big your room actually is.  And so let‟s 

create some headings on your spreadsheet that would give us, and allow you to specify what 

these dimensions actually are.  Let‟s choose cell C1 and enter the words „Model World Input‟. 

And right underneath that, we‟re going to enter the words „Room Dimensions‟.  Now these are 

going to be headings, and so we can make those look like headings by choosing the words and 

merging and centering those cells and making them bold.  

 

And do the same thing for the room dimension cells.  And for the room dimension cells, I‟m 

going to go ahead and fill that with a particular color.  Because underneath this, in this area 

here, is where we‟re going to enter the room dimensions.  Remember, you can change the size 

of the column widths by clicking on the right side of the box and then just moving that over, and 

it will give you more space so that you can see the words clearly.  



2 
 

 

Now our room dimension has a height, as we said.  And let‟s go ahead and give those the 

dimensions of centimeters.  And it has a length, also in centimeters.  And it has a width or a 

depth.  And what we‟re going to do in cell D3, D4, and D5 are select those cells, and those are 

where we‟re going to enter the actual dimensions of the room you‟re sitting in. Okay?  

 

So, by convention, we‟re going to shade those green.  And you can choose the paint can and 

then choose any color of green that you would like, and then give those a border.  And that 

helps you to realize and to quickly identify where your model inputs are.  So green signifies go. 

These are cells that are going to go into an equation that‟s used.  And you can change these 

directly. 

 

So let‟s enter a height of 1,200 centimeters, or 12 meters, a length of 1,000 centimeters, or 10 

meters, and a depth of 1,000 centimeters.  And those are our room dimensions.  

 

Our goal here is to figure out how many ping pong balls would fit inside this particular room.  

And so what we need to do is start by calculating what is the volume of this area.  And we can 

choose cells F1, and we‟re going to create a space in our spreadsheet that would record the 

model outputs.  

 

So in cell F1, let‟s enter the words „Model World Output‟.  And let‟s just enter the word, in F3, the 

volume of the room, or „Room Volume‟.  And that is going to be in cubic centimeters.  And so we 

can enter centimeters with the number 3 after it - see, up here in the formula bar.  So room 

volume, centimeters - and this should be a superscript.  And so select the number 3, and then 

choose the Font group box.  And when the formatting appears, go down and choose the 

Superscript effect, and then press OK.  Then either press the Enter key on your keyboard, or 

choose the enter checkmark up on the formula bar itself.  And that answer, we‟re going to put in 

cell H3.  

 

And this is going to become a model output.  So we‟re going to shade that in a blue-colored cell, 

and that‟s to signify that this is something that‟s calculated for you.  It‟s not something that you 

enter a number in.  So here‟s going to be an equation in this particular cell, whereas, these are 

just going to be plain old numbers. 

 

Now what is the formula that you need to enter to calculate the volume of the room?  Well the 

volume is simply the height times the length times the depth. So let‟s go ahead and type that 
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just so we have that in our minds over here - volume equals height times length times depth.  

 

And what we need to do in cell H3 is to enter that formula and reference the cells that are in 

green.  So, in this particular case, it‟s just simply the volume of the room is equal to D3 times D4 

times D5.  And notice that I used my mouse to click on those, as opposed to entering with the 

keyboard itself.  It just makes entering the equations much faster if you can just use your mouse 

and click on those references, rather than type that equation out by hand.  When you‟re 

finished, press the Enter button, and there we have the room volume for our hypothetical room 

here.  

 

Now, remember, this is called a Model World Input, because we‟re representing the key parts of 

the model.  And we‟re ignoring a whole bunch of things, such as the clock that Tony mentioned, 

or all the chairs, or the desks.  We‟re just thinking about what is - if the room is just represented 

as this box, then our question is going to be much more simplified, and we can start to get at 

what an answer might look like.  And then we can add in more details later, should we choose to 

do that.  

 

This is a section of our spreadsheet that‟s going to contain our outputs.  And so let‟s go ahead 

and make this bold, and merge and center those cells so it‟s clear that you‟re working with an 

output section here. 

 

What we want to do is calculate how many ping pong balls would fit within this particular box or 

room.  And so let‟s start by thinking about how to represent the ping pong ball itself.  I like to 

have some visual depictions of modeling problems up on the paper.  And so I‟m going to go 

ahead and go up to the Insert tab once more, and I‟m just going to add a circle.  Go down to the 

basic shapes and choose the oval, and then click some place on your spreadsheet, and it 

inserts a perfect oval or a circle.  And if I want to resize this and keep that perfect circle shape, I 

can push the shift key down, and then grab the corner, and that circle is maintained. So there‟s 

a ball.  And you‟ll have to imagine this is a sphere, as opposed to a circle.  

 

And one way that we talked about how we can represent this as we thought - can think of this 

as, instead of a sphere, we can think of these as sitting inside a little cube.  So let‟s go back up 

and add another little cube to our spreadsheet.  And this time, we‟re going to make the cube 

very small.  It‟s going to be the size of our ping pong ball.  So there it is.  We‟re going to put the 

ball inside this cube, and we‟re going to calculate how much area this ball actually takes up, or 

how much volume one ball takes up.  And if I know how many of these little squares there are, 
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then I can calculate how many of these little, tiny, tiny squares, or little tiny cubes, could fit within 

our bigger room.  

 

First, let‟s click on that cube, and go up, and you can see that the spreadsheet has added a new 

toolbar because I‟ve selected the cube itself, and it created a Drawing Tools tab.  And then 

under the Format tab, you can see there are three options here - Shape Fill, Shape Outline, and 

Shape Effects.  And let‟s choose the Shape Fill and just indicate that it has no fill.  And now we 

can stick our ball into this particular box.  And we can imagine now that our ping pong ball is 

sitting inside this tiny little box, tiny little cube.  And our goal, again, is to know how many of 

these little tiny things would fit inside this bigger thing.  

 

So what‟s the next thing we need to do?  In order to answer that question, we need to calculate 

and have an equation that calculates the volume of this tiny box, or tiny cube.  So choose cell 

C7, and let‟s enter the word „Cube model‟.   And this is going to become a header, so let‟s 

merge and center it, and give it some kind of a color to indicate it‟s a heading.  

 

And here, we know that a cube also has a height, a length, and a depth. But we also know that 

if it‟s a perfect cube, those dimensions are equal to each other.  So we only need to enter one of 

those dimensions.  So let‟s enter „Cube length‟, and this is going to be in centimeters, again. 

And we‟ll enter that - the length of that cube, in cell D8.  So this is an area where we can input 

something.  So let‟s shade that green and give it a border. 

 

And let‟s assume that our length for this particular cube is 4 centimeters.  That might be a pretty 

good-sized ping pong ball.  And you can change that if you want.  And that‟s the beauty of a 

spreadsheet is you‟ll be able to change these inputs, and we‟ll do that a little bit later.  

 

And then, given this cube length, now we can calculate the cube volume, which, again, is 

centimeters cubed.  And, again, let‟s go ahead and choose the number 3 up in the formula bar.  

Choose the Font option box, and then click on the Superscript effect, and you‟re set to go.  

 

And we‟re going to enter an equation in cell D9 that will calculate the volume of this little ping 

pong ball cube.  What would that be? 

 

It‟s the same formula that we used up here to calculate the volume of this bigger box here, or 

the bigger room.  We can do this as equal to the length times the width times the depth.  Or, if 

you don‟t like that option, you can simply just use the carrot and enter the number 3, which 
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would just indicate that it‟s - whatever value is in cell D8, we‟re going to cube that value to get 

our answer.  And that‟s a model output, so let‟s go ahead and shade that as blue, as we had 

done in the past. 

  

So now we have the volume of the room, and we have the volume of a tiny ping pong ball cube. 

Now we‟re able to calculate how many ping pong cubes would fill up our room.   

 

Click on cell F4, and let‟s enter the words „Number of Ping Pong Cubes‟.  And then in cell H4, 

this is going to be an equation that we‟ll enter, and so it‟s going to be an output.  So we‟ll shade 

that blue and give it a border.  And we‟re going to enter an equation that would just calculate 

that result for us. What would that be? 

 

Well it‟s just going to be the room volume divided by the ping pong cube volume, and that‟s our 

answer.  

 

If it makes it easier for you to read these numbers, you can select these cells, and then go up to 

the Number option box - group box, and choose the comma style.  And what you‟ll see is it - by 

default, the spreadsheet thinks that it‟s an accounting number, and that‟s fine.  If you want to 

hide the decimal points, you can just choose the Decrease Decimal button, and it will hide 

those.  And notice that it changed now to a custom number, which has commas but no decimal 

points.  

 

So let‟s think about what this answer means.  Is this really how many ping pong balls will be in 

the room?  

 

Of course not.  You‟ve taken a room - you‟ve simplified it by making it look like a box.  You‟ve 

estimated the height, the length, and the depth of that box.  Then you‟ve estimated the height, 

the length, and the depth of a cube that represents a ping pong ball.  And you‟ve come up with 

an answer that would tell you how many of these kinds of little ball - cubes, would fit inside this 

bigger room.  

 

So you‟ve got a model world input here, and you also have a model world output.  And what you 

need to do is to think about does this particular way of depicting your modeling problem really 

work?  Is it sufficient for you to go ahead and say, to somebody with some confidence, “Well I 

think there‟s about 18 million ping pong balls that would fit inside this room.” 
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Now one thing we need to do when we have a model that‟s set up like this is we need to do 

what‟s called a sensitivity analysis.  In a sensitivity analysis, we‟re interested in looking at the 

affect of how varying an input, which are in green here, affects the output of the model, which is 

our - our primary output is right here.  So how would this number change if we change any of 

these inputs that are listed in green?  And that is called a sensitivity analysis. We‟re looking at 

how the inputs and uncertainty in these particular inputs, any of them, might affect our key 

model output.  

 

So, for example, if the length were improperly measured, and it really is 1,500 centimeters, then 

we see that our number of cubes changes quite dramatically.  So there‟s some uncertainty in 

these numbers.  When we look at how uncertain these inputs are, that is what‟s known as the 

sensitivity analysis.  We have uncertainty in the room dimensions, and we also have uncertainty 

in the estimation of the size of the actual ping pong cube.  What if that was 3 centimeters 

instead of 4 centimeters?  The answers really change quite a bit.  

 

PAUSE the video:  Take some time on your spreadsheet now - and you can put this recording 

on pause any time you need to - and fiddle around and see how sensitive your answers are to 

changing these inputs.  

 

A second thing we need to do with our model is to do what‟s called an assumption analysis. 

An assumption analysis is different than a sensitivity analysis in that instead of just asking how 

sensitive is our model to changes in the inputs, we‟re going to ask is this really a correct way to 

depict the room itself?  Or is it a correct way to depict the ping pong ball volume itself?  

 

So here we‟re asking a fundamentally different question. We‟re asking how is it that we have 

represented our real-world problem, and is our model world output dependent on the 

assumptions we‟ve made about how we depict that problem, mathematically?  

 

So let‟s think about, now, calculating how many ping pong balls would fill up this room - not by 

treating the ping pong ball as a tiny cube but, actually, by looking at each of these ping pong 

balls as a sphere, itself.  And we‟re going to, now, in cell C11, enter some space for the sphere 

model.  This is another heading, so let‟s center and merge cells C11 and D11 and give them a 

color to indicate it‟s a heading.  

 

For the sphere model, we‟re not going to look at a ping pong ball as if it‟s sitting in a cube; 

instead, we‟re going to take that ping pong ball, and move it out of the cube, and then calculate 
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the volume of the actual sphere itself, rather than the volume of the cube.  So let‟s do that. Let‟s 

click on the little circle, and use your mouse to just click that, and then we can just copy that.  So 

go up to the ribbon and choose Copy.  And then click some place on your spreadsheet, and 

then paste that in.  And you can use Control V just as well.  And, in fact, let‟s go ahead and do 

that and paste in a few more spheres or balls just so we get an idea of what we‟re talking about 

here.  So now we‟ve got some spheres.  And you‟ll have to imagine this is a sphere once more.  

 

So do you remember how do you calculate the volume of a sphere?  Well if you don‟t know, 

that‟s okay.  I don‟t have that in the top of my head either.  I look it up. And the volume of a 

sphere is equal to four-thirds times pi times the radius cubed.  

 

And so, in order for us to calculate what the volume of a sphere is, we need to first enter the 

radius of the sphere.  So let‟s enter the words „Radius of a Sphere,‟ and we‟ll enter that in cell 

C12.   And I‟m going to go ahead and format that black as we had done before.  There‟s some 

formatting underneath my spreadsheet.  You won‟t have this problem.  

 

And that‟s going to be an input, and so we‟ll put our input, what that radius actually is, in cell 

D12.  So that‟s a model input.  And so let‟s go ahead and shade that green and give it a border. 

 

And here‟s where we enter the radius of a sphere.  So do you remember the radius is - you start 

at the middle of the sphere and move outward. And let‟s just say that it‟s two. 

 

Now, here, we need to calculate the volume of that - volume of the sphere, and this is going to 

be in centimeters cubed.  And just so that you remember the formula, we‟ll enter the formula 

down here, but let‟s first go ahead and make this number three a superscript.  So we‟ll go up to 

the formula bar and highlight the number 3, and then go into our Font box, and when the options 

pop up, go ahead and choose the Superscript effect, and then OK. 

 

This is now an output.  So we‟re going to use the radius of the sphere and the formula for the 

sphere.  And let‟s just write that right there in cell C14.  The formula for the volume of a sphere 

is four-thirds times pi times the radius cubed, 4/3 * pi * r3, And, again, let‟s make that a 

superscript.  

 

Just for your reference, I found that formula on a website, that I enjoy going to, called „Ask Dr. 

Math‟.  Because it provides, not only the formulas for these things, but it goes through how  
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those formulas were derived.  So this is a constant, this pi is a constant, and the radius is an 

input into the model.  

 

So we have everything we need to calculate the volume of that sphere.  And we‟re going to 

enter that in cell D13.  So that will be an output.  So let‟s go ahead and shade that blue and put 

a border around it. Okay? 

 

So let‟s go ahead and make our entry, „Equals 4 divided by 3 times‟   Now pi is a function in 

Excel.  So you don‟t have to remember what the number pi actually is.  So let‟s find that 

function.  We‟re up here in the formula bar.  And let‟s go ahead and find Insert Function.  And go 

ahead and type pi, P-I, and then Go, and it‟ll drop you down to pi, and you can just click OK.  

 

Just for your information, this is all there is to this particular function.  It‟s pi - open parentheses -

closed parentheses.  So there are no arguments in this particular function.  It‟s just 3.14.  

 

And then click OK.  So now pi is entered into our formula here.  And then we want to multiply 

that times the radius, which is in cell D12, and we‟ll cube that.  So we‟ll put a carrot, and then 

the number 3.  And then press Enter when our formula has been completed.  And that is the 

volume of the sphere.  Now this is the volume of the sphere, given that this is the radius of the 

sphere.  

 

And so the next thing we need to do is calculate how many ping pong spheres could be in the 

room, given that each sphere has this volume.  So let‟s go ahead, in cell F5, and type in 

„Number of Ping Pong Spheres‟.  And I‟ll drop this picture down so it‟s out of our way here.  And 

we‟re going to calculate that formula in cell H5.  So that will become an output, and give that a 

border.  

 

And we‟ll need to enter a formula in this cell that would calculate how many spheres would fit 

inside this room - given these dimensions, and given that the sphere, itself, has a radius of 2 

centimeters.  And, just before I forget, let‟s go ahead and put our units right there as well, in 

centimeters.  

 

PAUSE the video:  So what would that formula be?  

 

Well it would simply be the room volume divided by the volume of each little sphere.  And we 

press Enter, and we see that we can fit way, way more ping pong spheres than we can cubes. 
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So let‟s just think about why that is.  Well here we have four ping pong spheres.  So let‟s go 

ahead and put these and smash them all together as much as we can.  In the cube model, we 

counted the area of this ping pong ball, and we - by putting it inside a cube - these little corner 

areas were taken up.  And we said a ping pong ball can‟t possibly fit into these little corners 

here.  

 

In contrast, in the ping pong sphere model, we‟ve made different kinds of assumptions.  Not 

only are the balls close together, but this ball doesn‟t even have to retain its spherical shape, 

and it can kind of ooze into this area here, filling in the blank spaces so that there are no blank 

spaces at all.  

 

So we see that way more ping pong spheres can fit in than cubes.  How many more?  Well let‟s 

just take the proportion and find out.  Let‟s take one number and divide it by the other.  And we 

see that there is more balls when you calculate it with the sphere method compared to the cube 

method.  We could do that the other way as well by flipping these two numbers around.  And 

let‟s go ahead and try that.  H4 divided by H5, and you see now that this number is roughly 52 

percent of that number.  So that‟s quite a difference.  

 

And this is the root of what an assumption analysis does.  It says - if we treat our modeling 

problem as a cube, here‟s one answer.  And if we treat our modeling problem as a sphere, 

here‟s a second answer.” 

 

So what an assumption analysis allows you to do is to determine how the answers from your 

model world differ, depending on how we choose to represent the real world.  So, remember, 

we‟re taking a real-world problem, and we‟re trying to address it by using a model.  And how we 

represent that particular real-world in our model is what assumption analysis is all about.  

 

In other words, assumption analysis looks at how you represent the model itself.  So, in our 

case, how did we represent the room?  We represented it as a box.  And how do we represent 

the ping pong ball itself?  Do we represent it as a tiny cube?  Or do we represent it as a sphere 

with no spaces between?  

 

In contrast, a sensitivity analysis asks, “How do those answers change, depending on how the 

values change for the model inputs?”  So you‟ve already selected one set of assumptions.  So, 

for example, let‟s say we go with the cube model.  Now a sensitivity analysis is going to ask, 

“How do changes in the inputs in that cube model affect your key model output?”  And we do 
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the same thing when we choose a different kind of assumption, when we assume that the ping 

pong ball is a sphere.  We‟re still interested in doing a sensitivity analysis because we want to 

know how this number now would change as we change the key inputs into the sphere model.  

 

Now sensitivity analysis and assumption analysis are required parts of the modeling process. 

And if you go ahead and write a paper or present a model to some stakeholders, very often, 

they‟ll want to know and have it clearly stated to them, what are the assumptions of the model, 

and how sensitive are the results to parameter inputs? 

 

So we‟ll get lots of practice.  In fact, every week, we‟ll take some time and practice with our 

sensitivity and assumption analysis. 

 

So let‟s just take a few seconds now to summarize what we‟ve done with this particular 

spreadsheet.  We‟ve set up a rapid prototype of a model.  And this model was set up to 

determine how many ping pong balls could fit in the room that you‟re in.  Notice that it didn‟t take 

us much time at all to think about how to do this model and to get some numbers in place and to 

do a quick assumption analysis as well as a sensitivity analysis.  And that‟s the beauty of rapid 

prototyping is that it almost forces you to cut right to the chase and think exactly about how the 

problem in the real world could be represented in a modeling framework.  It was quick, wasn‟t 

it?  

 

With this simple spreadsheet model, we‟ve been able to provide a range of answers under two 

different kinds of assumptions, first assuming ping pong balls are cubes, and second, assuming 

they‟re spheres.  And we‟ve been able to arrive at a range of answers, given what our inputs 

are.  And we‟ve also, through this rapid prototyping session, we‟ve been able to zoom right into 

the main problems that are confronting us - and ignore things, such as the clock on the wall, or 

the desks and chairs - and just think of this problem, first, at its most basic scale.  And then 

we‟re at a point where we can build back in some of these more finer details that need to be 

addressed.  

 

Now, before we leave, I just have a quick question for you.  And this is for you to ponder on your 

own and build in as you wish.  How would you put Tony into this room?  

 

Okay.  We‟ll see you next time.  

 

< 00:33:52  END > 


